
Voyager SkyPad Help
Welcome!
Welcome to your new Voyager SkyPad!  This document will help
you become familiar with the device and the Voyager software
you'll be running on it.

Getting Help
First of all, if you haven't had a chance to watch the
comprehensive training videos on our Web site, you really should
as they will quickly get you up to speed on Voyager.  In particular,
please at least watch the following video:

http://www.seattleavionics.com/Videos/SkyPad.wmv

For using Voyager itself, the best way to find an answer to a
question is to use the extensive (really!) Help system built-into
Voyager.  When it's running, simply click the Help button or, if you
don't see one, press F1 or click the Help menu at the top of
Voyager.

If you're looking for a specific topic, try either the Index or the
Search tabs.  Index shows topics based on keywords we thought
would help you; Search performs a full-text search over the entire
Help file.

You can also find up-to-the minute Help on our Web site.  See
http://www.seattleavionics.com/support

If you can't find an answer either elsewhere on this page or in the
built-in Help, you can always email or call our support technicians. 
Support@SeattleAvionics.com or +1.425.806.0249.

Using the Touch Screen
 

http://www.seattleavionics.com/Videos/SkyPad.wmv
http://www.seattleavionics.com/support
mailto:Support@SeattleAvionics.com


The SkyPad uses a state-of-the-art multi-touch screen.  Among
other things, this means that it's easy to use with your finger. 
With older touch screens (including the original SkyPad), you often
needed to use a stylus for accurate clicks.  With the SkyPad this is
not only not unnecessary but won't work as the SkyPad is designed
for finger use.  Do not use your fingernail, stylus, back of a pen, or
glove -- simply touch the screen with your finger as you naturally
would.

Using the On-Screen Keyboard
When in Tablet mode (that is, the keyboard detached from the
screen), we provide an on-screen keyboard for situations in which
typing is required.

When using Voyager in GlassView (in-flight) mode, Voyager itself
provides a very large, specialized keyboard when text entry is
required.  When otherwise using the SkyPad, or if you're using
Voyager in pre-flight mode, you'll need to invoke the SkyPad
generic on-screen keyboard.  When you touch the screen (as
opposed to using the touch pad below the keyboard) to enter into a
text entry field, the SkyPad will briefly display the following icon:

Click it and the SkyPad will show an on-screen keyboard.

 

Using the SkyPad Controller

Screen Rotation and Brightness

Seattle Avionics includes the SkyPad Controller for rotating the
screen, adjusting the screen brightness and turning the unit off (or
to sleep).

In the lower left of the screen, next to the Internet Explorer icon,



you'll see the SkyPad Controller icon (blue sphere with a yellow
gear).  Press it to show the SkyPad Controller.  You can also press
a hardware button around the screen bezel that looks like a square
with a finger.

Use the SkyPad Controller to rotate the screen, select any of the
three brightness levels or turn the unit off.  If you don't select an
action within about seven seconds, the SkyPad Controller
automatically closes itself.

Tip: Voyager can't be rotated once it starts.  Thus, the SkyPad
Controller will not let you rotate the screen if Voyager is running. 
Simply close Voyager (saving an open flight plan, if necessary,
first) then rotate and re-start Voyager.

Once Voyager starts, all tablet rotation is automatically disabled
until Voyager is closed. The two hardware bezel buttons are also
disabled while Voyager is running.  In the event that Voyager
unexpectedly quits, you can restore normal screen rotation and
bezel button functionality by clicking the SkyPad Controller icon as
described above.



Tip:  Voyager's pre-flight planning screens are designed for
landscape screen orientations (that is, a screen orientation that is
wider than tall).  While you can use the pre-flight planning features
while in portrait orientation (the orientation best for in-flight use),
you should rotate the screen such that the device looks like a small
laptop before serious planning as a keyboard is very helpful.

Power Off versus Sleep

When you don't need the SkyPad, you can put it to sleep or turn it
off with the SkyPad Controller.

Press  to show the SkyPad Controller.
Click the red Power button to select either Sleep or Off.
Select the desired function (Turn SkyPad Off or Put SkyPad
to Sleep).

Tip: In this context, "sleep" means the unit will appear off except
for a blinking light.  However, power will continue to be used, albeit
very slowly, because the machine will be in a state that lets it turn
back on, exactly where you left it, in a few seconds.  To turn it
back on, slide the power switch on the side of the unit.  "Off", by
contrast, is really completely off -- no power used and the system
will take some time to completely restart when you turn it back on.

Tip:  We do not recommend putting the SkyPad to sleep while
flying because resuming from sleep usually causes problems for
Voyager.  Should you inadvertently put the SkyPad to sleep while
Voyager is running, you should exit then restart Voyager once the
unit wakes up.

Flying with the SkyPad
The SkyPad can be used as easily as any dedicated aviation GPS
but can do much more. You can simply go and fly without creating
a flight plan or the SkyPad can create a detailed wind-optimized
flight plan first.

Option 1: Just Fly - No Flight Plan

Turn the SkyPad on by pressing and holding the power button
on the side of the device.
Turn the GPS receiver on (press and hold the power button on
the top edge of the device).

Double-click the Voyager 4 QuickFly icon  on the
SkyPad's desktop.
Voyager will start and, after about a minute, open a moving



map to the location determined by the GPS.

Option 2: Create a Flight Plan then Fly

You get much more benefit from using your SkyPad when you plan
a wind-optimized, fuel-price optimized flight plan before you fly. 
To do that:

If possible, be sure that your SkyPad is connected to the
Internet via either the Ethernet jack or Wi-Fi.  This allows it to
automatically download weather (which can be displayed in-
flight even without an Internet connection), TFRs, and fuel
prices.  If you cannot connect to the Internet, the planning
and in-flight features still function although the system won't
be able to wind-optimize the flight plan.
Ensure that the SkyPad is in landscape configuration (the
screen wider than tall because the screen cannot be rotated
once Voyager starts.  If it's in tablet configuration (screen
taller than wide), close Voyager if it's running then click the

SkyPad Controller icon  in the lower portion of the screen
and use the Rotate button.  It's also very helpful, for flight
planning, if you attach the keyboard.

Double-click the Voyager 4 icon  on the SkyPad's
desktop
When you see the Task Window (it says "What do you want to
do?" at the top of the screen), select Plan a Flight and click
OK to use the New Flight Plan Wizard to plan the flight.  Once
you're familiar with the system, you can bypass the wizard by
entering your takeoff and landing airport idents in the text
field below the Create a new flight plan without using the
wizard option.
Save your flight plan.
File the flight plan by clicking the FAA/ICAO button the main
toolbar or selecting File FAA/ICAO Flight Plan from the Plan
menu.
Close Voyager by selecting Exit from the File menu.
Set your SkyPad for optimal in-flight configuration by
undocking it from the keyboard (if attached) and turn the
screen into what's called Portrait configuration (screen taller

than it is wide) by clicking the SkyPad Controller icon 
and using the Rotate button.
Launch Voyager directly into moving-map mode by double-

clicking the Voyager 4 QuickFly icon .
After Voyager starts up, it will show you a list of recently used



flight plans.  The plan you just created should be at the top of
the list.  Select it and click OK if you want to load that flight
plan.

Getting Information

Voyager is very "tab" oriented.  All the information you need for
routine flying is displayed on a series of tabs across the screen. 
You'll generally see tabs for Chart (map), Airport Information,
NavLog (review and edit your flight plan), Procedure, Nearest
Airports/Navaids, Winds Aloft, Scratchpad (for taking notes),
Gauges and more.  Just click the appropriate tab for information. 
Remember that if you switch away from the Chart tab, just click
Chart to get back to the moving map.

To get information about an airport or navaid, either select it from
the Nearest tab or click on the Chart.

Moving/Zooming the Map

To temporarily move the map (sometimes called panning the map),
use your finger to click and drag the map.  If you accidentally click
the map rather than drag it, Voyager may show information about
the area you accidentally clicked on.  Just try again and, this time,
be sure to keep your finger pressed to the screen as you move it. 
When you're ready to move back to your current position, click the
yellow warning at the top of the map that says GPS centering
off.  Click to engage.

At the upper right corner of the map, you'll see a number which
indicates the current range (or zoom).  This number is the radius in
NM from the center to the nearest edge of the map.  The easiest
way to zoom in or out is to click that number.  Voyager will show a
list of other possible zooms.  Click the range you want.

You can also use the standard "pinch-to-zoom" features you expect
on a tablet.

Changing Chart Types

Your SkyPad comes pre-loaded with digital and our exclusive
"seamless scanned" charts for both IFR and VFR flying.  Click the

large Chart button  at the bottom of Voyager and
experiment with different types of charts.  Give the system a few
seconds after each switch for the screen to completely redraw,
especially when using the scanned charts.

You can also turn individual chart elements (what we call layers)
on or off by clicking the large icons on the upper ChartBar. 



If you create a new combination that you really like, you can save
it by clicking Chart then selecting Save Chart Settings.

Voyager can display the map as either a traditional 2D map or a

Highway In The Sky 3D view.  Use the 3D button  to toggle
between the two.  Tip:  The 3D view looks best when terrain is
on.  Since it's off in the IFR chart themes, we suggest you select
the Sectional (Digital) chart theme before entering 3D mode.

Normally Voyager displays the map in Track Up mode so that
what's in front of you, regardless of your direction of flight, is
"up."  if you prefer, you can use North Up mode.  Switch between

the two modes by clicking the Track Up/North Up button . 
Tip:  When using a scanned chart theme, it's normally best to use
North Up so you can read the text.

Weather

Your SkyPad can either use what we call SmartWeather (weather
downloaded from the Internet the last time the SkyPad was
connected to the Internet) or from an optional XM receiver.  Either
way, displaying weather is identical.  You can turn individual
weather layers on or off using the ChartBar at the top of the

screen.  You can also click the Wx button  at the bottom of
the screen to switch the entire view to weather or just add radar
and winds to the current chart theme.

Tip:  On a flight that requires a stop, you can update your weather
enroute by connecting to a Wi-Fi hotspot at your FBO (most have
then but you may need to ask). 

Connect the SkyPad to the Internet in the usual way.  You
may need to ask the FBO about the name of their Wi-Fi
network and/or the password.
Verify Internet access by opening a Web browser.

Launch Voyager in pre-flight mode (that is, the  icon). 

Important!  Do not use the QuickFly icon  to launch
Voyager (and close Voyager if it's already running in QuickFly
mode) because QuickFly automatically disables Internet
access.
Open your flight plan



Give the system a few minutes to download all the weather. 
You'll see text messages with weather download progress in
the lower right corner of the Voyager window.
Close Voyager.

Antivirus Software
You've probably read the horror stories of someone's computer
being destroyed by a virus.  Perhaps it even happened to you. 
Nonetheless, we VERY STRONGLY suggest that you DO NOT add
any virus protection to your SkyPad as it dramatically decreases
performance.  Instead, we suggest you practice "safe computing"
and, as our Technical Support Manager likes to say, "Don't visit
Web sites that you wouldn't want your mother to know about."

Using the GPS
Technically, SkyPad is not a GPS in that the actual GPS receiver is
not built-into the device.  The SkyPad talks to the GPS receiver via
a wireless technology called Bluetooth (the same thing that lets
your cell phone talk to your car or headpiece).  Generally speaking,
Bluetooth devices need to be "paired" with each other to work. 
This pairing is what lets each device know it's OK to talk to the
other device.  Without pairing, you could be walking down the
street with your cell phone and suddenly see it latch onto all the
other cell phones in the area!

If you purchased your SkyPad with the GPS, we've already paired
your machine with your GPS and you don't need to do any thing
other than turn it on an occasionally recharge the battery.  If you
need to re-pair the devices for some reason, try to do the following
before a flight because it might take some time.  You'll also need
to do this if you're using a Bluetooth GPS you already had with the
SkyPad.

Ensure that your GPS is on.
Click the Bluetooth Devices icon  in the Windows system tray (lower
right corner of the screen).
Select Add a Device.
If you see your GPS listed, select it.  If you're using the GPS we supplied, its
name will begin with BT-GPS.

If you don't see your GPS, ensure that it's turned on and near the
computer.

Click Next.
Click the option Enter the device's pairing code.
Enter a pairing code number for the GPS.  The code for the GPS we provide
is 0000. If you're using your own GPS, you'll have to check your manual or
contact your GPS vendor for the proper code.
Click Next.
Assuming you don't see any error messages, your GPS is ready to use but
you still need to tell Voyager how to find it.  The GPS communicates
wirelessly using Bluetooth but, to Voyager, the GPS must be connected via a
technology called a COM (for Communication) port. Voyager needs to know



which COM port to look at. Therefore, click the text link that says Devices
and Printers.
Double-click the icon for your GPS.  It will probably look like generic silver
box.
Select the Services tab.
Take note of the COM port shown (probably something like COM 3).
Close any open windows.
Start Voyager using the Voyager 4 (not Voyager 4 QuickFly) icon.
When the Tasks window appears, close it.
Select Options from the Tools menu.
Select Preferences then GPS.
Ensure that Voyager is set to Use the COM and Baud settings below (not
the automatic setting) and that the same COM port that was noted above is
selected for Voyager.
Click the Test settings button and wait.  In about 30 seconds, perhaps as
must as one minute, you should see a yellow or green status bar appear in
Voyager.  If the status indicator stays red, the COM port setting is not
correct or the GPS is off.

Using an XM Receiver
Properly configuring an XM receiver can be tricky.  Please contact
Seattle Avionics technical support at +1.425.806.0249 for more
information. 

Daylight Issues
While the SkyPad has more "nits" of brightness than many laptops,
there are times when you might find it necessary to employ some
tricks to read the screen:

Angle the device away from the direct sunlight.
Use a book or piece of paper to shield the device from the
direct sunlight.
Switch to a Chart Theme that has high-contrast such as the
IFR Enroute Low-Altitude theme (black text on a white
background).  Or, if it's a VFR flight, turn terrain off by
clicking the terrain button on Voyager's ChartBar (top of the
screen).

Night Issues
For night flying, be sure to turn the screen brightness down as
much as possible to avoid night blindness issues.  To do this, click

the SkyPad Controller icon  at the bottom of the screen and
tap the Night button. 

Install Voyager on Another Computer
Your purchase of the SkyPad allows you to install Voyager on up to



three machines (two plus the SkyPad itself).  This makes it easy to
use a desktop computer at home or work to plan your flights,
check the weather, etc.

To install Voyager on another computer, you should go to the
Seattle Avionics Web site

http://www.seattleavionics.com/Voyager/DownloadRequest.aspx 

and download a new copy rather than use any Voyager CD you
may have.  This ensures that you get the latest version of Voyager
and current data.

In addition, you should perform a Web Synch (explained below)
from your current Voyager installation before installing on the new
machine.  This will save you considerable time and effort as the
new installation will use the information stored by Web Synch for
the new computer, rather than make you type in the same
information again.

Tip:  When you install to the new machine, be absolutely certain to
use the same email address to activate as you did for the
SkyPad.  We use email addresses as customer IDs so any
difference in email will make the new installation look like it's for a
different person.  This will cause activation problems and data
concurrency issues.

Using the SkyPad With Another
Computer (Web Synch)
Web Synch is a unique feature of Voyager that makes it easy to
synchronize information between multiple computers. This is very
helpful if you want to use a desktop machine to plan your flights,
for example.

From Voyager, select the Web Synch command from the File
menu.  Voyager will bi-directionally copy the latest version of your
pilot information, plane information and all flight plans between the
machine and our Web server.  Then, on the SkyPad or any other
machine running Voyager, perform Web Synch again and the new
flight plan will be transferred to the SkyPad.

Thank you from the crew of Voyager!  Don't hesitate to contact us
about issues or suggestions.  We actively look to incorporate your
feedback into future versions of the SkyPad and Voyager.

http://www.seattleavionics.com/Voyager/DownloadRequest.aspx

	Local Disk
	Seattle Avionics | Voyager SkyPad Help


